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1 Introduction

1.1 Manual Purpose

; This manual is a guide to the use of the Support
Cross-references (in bold Tool (Upload/Download) program which is

(7D (S e Al s used with the ID5x/6x Series Fire Control
links. For example, click on

(see Section 4) to go to Panels.
that Section.
Related Documents

This manual should be read in conjunction with
the following documents:

a. Installation, Commissioning & Configuration
Manual.

b. Operating Manual.

System Design and Planning
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It is assumed that the system, of which the
ID5x/6x panel is a part, has been designed by
a competent fire alarm system designer in
accordance with the requirements of EN54
Part 14, BS 5839 Part 1: 1998 and any other
local codes of practice that are applicable.

Be aware that...

This manual is not intended to be a fire
detection system design guide and should only
be used by (or under supervision of) a qualified
system design engineer.
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1.2 General

Before connecting a PC to Sygtem configuration _files can be_ prepared
the Panel, refer to using any IBM-compatible PC in offline mode,
Section 2. Incorrect (i.e. you do not need to be connected to the
connections could result in panel itself during data preparation). Only when

damage to the comms port

of the PC. the system configuration file is complete does

the PC need to be connected briefly to the
panel. Then a simple operation, initiated with
a few keystrokes and taking only a few
minutes, is sufficient to program the data into
the panel.

In addition, you can initially connect your PC
to the fire control panel to read the data from
the panel - this takes only a few seconds. The
PC can then be disconnected from the panel
and moved to a more convenient place for
editing. Once editing is complete the PC is
re-connected to the panel and the edited data
sent to the panel. During the read and send
operations the panel is still functional, except
during the brief time period required for data
transfer.
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The Support Tool is fully Year-2000 compliant.
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1.3 Hardware Requirements

1.3.1 Computers

It is recommended that the Support Tool runs

Make sure a pointing on an IBM PC-AT compatible, Pentium-class
device is installed when PC, running under Windows® 9x with
using the Support Tool on 16MBytes of memory or Windows® 2000/NT
a laptop. with 32MBytes of memory and with Internet

Explorer 4, or later. The PC must be equipped
with at least one serial port and (preferably)
one printer port. For optimum performance it
is recommended that the PC has, as a
minimum, 32MBytes of free memory (RAM)
and 35MBytes of free hard disk space. The
PC monitor should be configured with a screen
resolution of at least 800 x 600 pixels.

If you experience any problems, contact
NOTIFIER or your computer supplier.
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1.3.2 Printers

The Support Tool will allow you to print the data
files on any configured Windows™ printer
connected to the serial or parallel port of your
PC. There are no special printer drivers in the
software and the more sophisticated printers
(e.g. some laser printers) may not operate as
expected.

Consult NOTIFIER if you experience difficulty.

3 997-405, Version 2.7
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1.3.3 Data Transfer Lead

1.4

A Data Transfer Lead (PN: 082-173) with
‘straight-through’ male to female 9-way ‘D’-type
connectors is required to connect the Panel to
a standard PC RS232 port. One lead is
supplied with this Support Tool kit
(PN: 020-562).

Backing Up

When installing this program on a PC, follow
the online installation procedure. Make back-
up copies of all configuration data files. Keep
the master Compact Disc in a safe place.

997-405, Version 2.7
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2 Installation

Before either a panel configuration file can be
received by the PC or a configuration file can
be sent to the panel, a connection must be
made via the RS232 Interface connections.
Jumper links must be set appropriately. The
procedure is given in the panel’'s Installation,
Commissioning & Configuration Manual (in
Section 2.8, RS232 Interface Connections).

After successfully transmitting/receiving the
panel system configuration, the PC may be
disconnected.
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3  Starting the Program

Before the Windows™ Support Tool program
It is NOT possible to run can be started, it must be installed on a suitable
computer (see Section 1.3.1 Computers).

the Support Tool
Run the CD and follow the on-screen prompts.

program from the CD.
During installation you are prompted to select
the installation setup language. Choose the
desired language from the drop-down menu.

Choose Setup Language Note: An alternative language can be selected
% Select the language for this installation from at any time after installation from a
the chaoices below.

configured list of languages (see
Section 5.4 Tools Menu).

|Engish

Eodlsh To run the Support Tool program, either:
French [Standard)

a. From the Start menu, select Programs/
Notifier Limited/ID5x&6x Series/ID5x&6x
Series Tool (or the path in which the
program was installed, if different), or

Portugueze [Standard]
Spanigh

b. Double-click the ID50Tool.exe icon in
Windows™ Explorer.

When the ID50Tool.exe program is opened,
the following Support Tool window is displayed:

@NE‘#’ FILE - ID5%/6x Senes Windows Support Tool V2. 60 [UNREGISTERED)

File Edit Wiew Tools Help

DORESR B

Parel Address | Description Zone | Type | Alaim | PA Dayp PD | Group |+
-l Onboard Outputs R
EIC:J Loop B 2 1 100% 100%

Ll =

3 1 100k 100%

""" Medules N 4 1 100% 100%

] 1 100% 100%
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January 2005



ID5x/6x Series Panels - Offline Configuration Manual

x Series Windows Support Tool

&} 1D54/6x User Manual — F1

Ao, Chil+a F \

=

Reagister

rLicenze Detail

Your copy of the Offline Configuration Tool needs to be registered before
you can send any files ta a |D5x/5x Panel. If pou do not want to register
the program now, press OK.

To arrange a licenze, contact:

Motifier Europe (Tel. +44 [0) 1444 230300)

*r'ou will be azked for the following detailz:-

Customer Code: AAFGE-7716C-E5601

Enter License Key |

License ,

License Kew:

How to Register the Support Tool

An unregistered Support Tool has restricted
functions. The Tools drop-down menu is
inoperable (greyed out) - except for selection
of language and VdS Compatibility mode - and
it is not possible to communicate with a panel
or change the Serial Port Setup.

To register the Support Tool:

1 Start the Tool and, from the Help menu,
select the Register option. The Register
dialogue window is displayed.

2 Note the customer code and enter it
(together with the other requested data) on
an Authentication Request form.

Note: Authentication Request forms are
available from Notifier - phone Technical
Support on +44 (0) 1444 237923.

3 Fax the Authentication Request form to
Notifier on +44 (0) 1444 254038. Notifier
will supply a licence key (valid for a specific
PC only) in response.

4 Onthe Register window, select ‘Enter Licence
Key'. The Licence window is displayed.

5 Enter the supplied key into the Licence
window and select OK (or Cancel, to ignore
the registration). When registered the
Support Tool is fully operational.

Note: If the Tool is installed on a different
physical OR logical hard drive (e.g. on
partitioned drives), you will have to
repeat the whole registration procedure.

997-405, Version 2.7
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3.1.1 Licence Re-registration

When the Support Tool Program licence has
& il 50 s fereig o e leemse less than 31 days to run, a warning is displayed

at startup (see opposite). Re-register the tool
following the procedure described above.

3.2 Using the Support Tool Program

The program is very easy to use, with all
functions either selected via menus or function
keys:

a. Current selections are highlighted in

reverse video (see opposite).

I Address I Description IZnneI Type I Alarm I PAI Day I PDI Group |L|

1 1) -
e I Y N T N [T
1 B

1007% 100%

100% 100%
100 100%
1007 100%
1007% 100%
0 1nne

1003 1005

BRI AR

b. Press the <ALT> key and use the cursor

arrows to step through the different options,
Alt I... — or type the underlined character from the

required function.

£
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c. Alternatively, use the mouse to select the
appropriate function.

d. While you are editing, the Help file can be
accessed via function key F1.

The functions available under the various
menu options are described in the remainder
of this manual.

8 997-405, Version 2.7
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4 Open a File/Create a New File

@ NEW FILE - ID5x/6x Series Win A new configurgtion file template or an existing

: — configuration file template can be accessed
File Edt Yiew Tods Help using the standard Windows™ ‘New’ and
OAald &E & 2 ‘Open’ commands. These commands are

available at the top left corner of the Support
Tool startup window. Files can also be opened
by dragging and dropping onto the Tool
window.

Fanel
i) Onboard Oubputs

The ‘New’ and ‘Open’ commands create and
load files with the extension ‘.udf . If an old .udf
file is opened, the version number is
automatically updated and a ‘Save’ request is
made.

4.1 NEW File

@ NEW FILE - ID5x

To create a new configuration file, either:

a. Press the ‘New’ icon on the toolbar, or

b. Selectthe ‘New’ option from the File menu.

& save Crl+5 A new blank template will be displayed (see
e fin Section 4.3 Configuration File Template).
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@ HOTIFIER_UDF - ID5x/6x Series Windows Support Tool ¥2 5!

JaR Edit Yiew Toolz Help

| Mew Chrl+M

@ Open... Ctrl+0

u Save Chrl+S
Save fs.

& Print Previews

&P Fiint Chil+P
Printer Setup

1 C:\Program Files\MOTIFIER Limited% D5x6% Senes Tool\MOTIFIER. UDF
\

HISTORY

LIST

Open File 12}

Laoak in: I 4 lssueFiles

I s =i sl

I Main Building. JDF

File name: I

Files of type: IIDEm"Bx Configuration File

Open I
j Cancel |

4.2 OPEN File

To open a previously-stored configuration file:

a. Selectthe ‘Open’ option from the File drop-
down menu to display the ‘Open File’
dialogue window, typically as shown at left.

Use the standard Windows™ navigation
tools to search for and open the required
file.

or

b. Select a file from the history list. When a
file is selected from the history list a
template will be shown with the
configuration settings stored in the file.

Refer to Section 4.3, Configuration File
Template.

10
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4.3 Configuration File Template

The Configuration File template is displayed
when opening a new file (as shown below) or
a previously-stored configuration file (*.udf).
The new file template will not contain any
specific system data, i.e. it is blank, whereas
a previously-stored file contains saved
configuration data.

The Configuration File template comprises four
main areas (see illustration below):

a. Menu tool bar.

b. Command button tool bar.

c. Connection view.

d. Device list/configuration view.
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5 Menu Tool Bar

The Menu tool bar contains the following
menus:

File.
Edit.
View.
Tools.
e. Help.

() NEW FILE - ID5x/6x Series Win

Fanel
-Gl Onboard Outputs

a0 oo

The options selectable from each Menu are
described in the following sections.

5.1 File Menu

The File menu has the following options:

L )
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New Creates a blank configuration file.

Open Opens an existing configuration
file.

Save Saves the current configuration
to the file.

Save As Saves the current configuration
with a new name or to a new
file location.

Print Preview View configuration details to
print.

Print Prints the configuration data.

Printer Setup Allows change of print settings.

‘History List’” Lists previous configuration
files opened.

Exit Closes the current session.

12 997-405, Version 2.7
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5.2 Edit Menu

The Edit menu has the following options:

Cut Device Removes the selected device,
with its details, and places it on
the clipboard.

Copy Device Places the selected device,
with its details, on the clipboard.

Paste Device Only available after either
copying or cutting information.
Inserts the contents of the
clipboard at the insertion point
or replaces any highlighted
selection.

5.3 View Menu

The View menu has the following options:

General Setup

Options Allows general setup options to
be viewed and/or changed.

Onboard Output

Circuits Allows the configuration of the
onboard circuits to be viewed
and/or changed.

Zone Text Text assigned to each zone
may be viewed and/or changed.

CBE Rules Control-by-Event (CBE) rules
associated with modules and
onboard output circuits may be
viewed and/or changed.

13 997-405, Version 2.7
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Toolz

Chrl+T
Chil+F

n Send to Panel
% Beceive from Panel

Fetch Event Log
Fetch Device Data

Log Device

,,éyr Senal Port Setup Chl+E

Language L

() Panel Event Log

Save bz,
E xit

.CSV = comma separated
values Excel file

Serial Port Setup

Senal Port

oK

Cancel |

5.4 Tools Menu

The Tools menu has the following options:
Send to Panel Transmits the current saved

configuration information to the
panel.

Receive from Panel

Retrieves the current configuration
data from the panel and loads
it into the PC’s memory.

Fetch Event Log/Fetch Device Data

Log Device

Retrieves the event log or
device data from the panel. A
‘Save As’ option allows the log
or datato be saved as a .csv file.
While the Tool is connected to
the panel, this option allows a
device to be logged in real time
on the Tool (select the Sensor
or Module address, use the
slider to set the logging interval
[range 5 to 60 seconds], then
Start. The data can be saved
as a .csv file.

Serial Port Setup

Selection of this menu displays
the window at left. To assign a
serial port other than ‘COM 1,
use the down arrow to display a
list of other comms port options.
Click the ‘OK’ button to confirm
and return to the configuration
file, or ‘Cancel to return without
changing the selection.

14
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About ID5x/6x Series Windows Support Tool

Q)

Wind
Tool

OWS S

upport

5.5

Language

Presents a list of configured
languages and the ‘VdS
Compatibility’ option. Select the
required language from the drop-
down menu (the language change
is implemented immediately).

VdS Compatibility

Help Menu

Changes the functionality (some
CBE defaults) to comply with the
requirements of VdS (Germany).
To ensure all relevant defaults
are set when opening a new file,
select 'VdS Compatibility’ first,

then open the file.

The Help menu contains the following options:

ID5x/6x User Manual

Register

About

Displays the Offline Configuration
Manual providing appropriate
software has been installed.

This option is only available
with an unregistered Support
Tool. Refer to Section 3.1, How
to Register the Support Tool.

Displays a window showing
software part and version
number, NOTIFIER’s website
address and available PC
memory. Also displayed is the
licence time remaining (in
days). See Section 3.1.1.

Press ‘OK’ to Exit.

15
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@ MOTIFIER.UDF - ID5x/6x Series

6

Command Tool Bar

The Command tool bar contains eight standard
Windows™ icons:

@

h.

-~ 0o o 0 T o

New File (Ctrl+N).
Open File (Ctrl+0O).
Save File (Ctrl+S).
Print (Ctrl+P).

Print Preview.

Cut Device (Ctrl+X).
Copy Device (Ctrl+C).
Paste Device (Ctrl+V).

Each icon operates as in standard Windows™
applications. The icons are described in
Section 5.1, File Menu.

16
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7 Connection View
E. =p— The Connection View pictorially shows the
) Onboard Dutpuits outputs and signalling devices connected to
F the panel.
: The view can be expanded (+) or collapsed (-)
2 as in the standard Windows™ Explorer. To
5 expand or collapse click the LEFT mouse
4 button on the required icon (+ or -) or text header.
9 You can use the mouse buttons to navigate
""" w? Addiess B and select options within the Connection View
""" ~? Address 7 as follows:
----- i Addrese 8
""" v Address 3 Left mouse button - Navigate
[=-{F] Modules
(M Address 1 Panel  Displays the Setup Options screen
(Ml Address 2 in the Configuration View area.
- {H] Address 3
[ Address 4 Onboard .
[ Addriess B Outputs View the Onboard Outputs Setup
[ Address B screen in the Configuration View area.
[ Address 7 Loop  View the loop device list (sensors -
~ [l Address 8 default) in the Configuration View area.
] Addrezs 9
Sensors (Sensor
Address) View the sensor loop device list in
the Configuration View area.
Selected device is highlighted.
Modules (Module
Address) View the module loop device list in
the Configuration View area.
Selected device is highlighted.
17 997-405, Version 2.7
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Send to Panel Chl+T
Beceive from Panel Chl+R

Al "

Onboard Dutput Circuits Chi+D
CBE Rulez Chil+B
Zaone Text Chrl+2

CBE Fues CubB |

E--“ Fanel

o) Onboard Outputs
H  Add/Change  » EEESTERERTH
Delete b Modules |
E--n Panel Address I
Ql)) Onboard Dutputs 1
Sensors
Modules
P Address 3 .
L Address 4 ALL Devices

Panellcon

Right mouse button - Options

Right-click on this icon to display the
following drop-down menu options:

Edit
Send to Panel (Ctrl+T)
Receive From Panel (Ctrl+R)

Edit options are: Loop Devices, Onboard Outputs,
CBE Rules or Zone Text. Refer to Section 5.2.

Send to Panel - refer to Section 15.1. Receive
from Panel - refer to Section 15.2.

Onboard
Outputs

Loop

Sensors

Modules

Displays the CBE Rules drop-down
menu; left-click to select ‘CBE Rules'.

Displays a drop-down menu with
options to Add/Change or Delete
devices; also selectable from an
individual address icon.

Select ‘Add/Change’ for Sensors or
Modules.

Select ‘Delete’ for Sensors, Modules
or ALL Devices.

You are prompted to enter sensor
address/range, type and specified
zone. Refer to Section 11.1.

You are prompted to enter module
address/range, type and specified
zone. Refer to Section 11.1.

ALL Devices

Delete option only. You are
prompted to confirm/cancel
selection. Refer to Section 11.3.

18
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S
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Device List/Configuration
View

The device list/configuration view on the right-
hand side of the Support Tool window presents
one of the following four displays:

a. Setup Options (five tabs).

b. Onboard Outputs.

c. Sensor Device list.

d. Module Device list.

Typical Setup Options and Onboard Outputs
displays are shown at left. Typical Sensor and
Module Device lists are shown on the next

page.

19
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Sensor Device List

Note: This display provides access to the
‘Alarm’ and ‘Day’ (Day Mode) sensitivity
fields (Section 11.1.4). Fields are also
available for the configuration of VIEW™
sensors and other device groups except
for device type TMP (Section 11.1.4).

Eﬂ Panel Address | Description IZonel Type | Alarm I PA | Day | PD I Group I;I
4’)) Onboard Qutputs | 1 reception 1 THP  100% 100%
EC:J LDD | 2 warehouse 1 1 0PT 100% 100%
= Bkl : || 3 warehouse 2 110N 100% 100%
o Addross 2 || 4| warehouse 3 1HMLT L3 L3
_____ o Address 3 || 5 warehouse 4 1 THP  100% 100%
..... i Address 4 || 6 warehouse 5 1 THP  100% 100%
..... P Addres: B || T office 1 1 AVS L7 L6 L4 L5 1
----- P Address B || 8 office 2 1 AVYS L8 L7 LS L3 1
----- a7 [y oifices | ilavn |17 Lo | L4
""" = Address 8 10 1] 100% 100%
----- i Address 3 I f pranes P
Module Device List
Note: This display provides access to the CBE
Range Entry window (Section 11.1.6).
Eﬂ Panel Address | Description | Zonel Type | Action | CBE Rule |d
-l Onboard Dutputs 1 Reception 1 MCP
E-CY Loop B 2 Warehouse 1 1 MCP
e Sensae N 3 Warehouse 2 1 SDR (+1)1,21
] e 1 || 4| Warehouse 3 1 ALY (11
] Address 2 || 5 Warehouse 4 17 AUX PLANT ALARM
M Address 3 || & Warehouse 5 17 AUX  PLANT ALARM
= Addresz 4 || 7 Office 1 1 5DR (+131.12
Address 5 || 8 Office 2 1 MCP
3 Address B 9 Office 3 1 MCP
[P Address 7 10 1.
[P Address 8 I 1
[P Address 9
12 1
20 997-405, Version 2.7
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Setup Options

The Setup Options display enables you to edit
the panel’s Setup menu options. The display
has five tabs:

a.

Panel Options. Enables you to select the
Panel Type, Set/change the Date Format,
select the Control Keys access level, select
printing modes and select the following
actions: function of Control Key 3 (VdS
only), LEDs 1H and 2C and the un-mute
function of the internal buzzer with new
alarms.

Site Details. Enables you to enter/edit the
Site Name and Service Telephone Number.

Device Options. Enables you to set/select
Device Blinking, Automatic High Test time,
Digital Input 1 function, Transmission
Device mode, FWP Input 4 Disable, Pulse
Ratio, and Extinguishing System functions.

. Peripheral Options. Enables you to set/

select the number of repeaters, their
protocol, and the RS232 port mode.

Day/Night Settings. Enables you to
activate/deactivate the Day Mode and/or
Weekend Night Mode and configure Delay
Timers.

To view the Setup Options display, select the
Panel Icon in the Connection View area on the
left-hand side of the Support Tool window; the
Device List/Configuration View area displays
the current settings.

21
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9.1 Panel Options

The Panel Options tab allows you to set the
following:

a.

Panel Type. Highlight the type from those
available in the list. Restricts the options
available in the Support Tool to those
appropriate to the selected panel. Panel
Type s stored with the configuration and is used
to generate a warning if this is incompatible
with the panel. It is set automatically when
a configuration is received from a panel.

Date Format. Highlight the required format
from those listed (options are dd/mm/yyyy,
mm/dd/yyyy, yyyy/mm/dd).

Control Keys Require Level 2 Access.
Click the ‘Yes’ button for access level 2, or
the ‘No’ button for access level 1.

Control Key 3 Mode. Applicable to
NF-Series panels only. Key function can be
set as Transmission Device Enable/Disable
or End Delay/Evacuate.

Event Printing. /D51/52, ID61/62 only.
Click either ‘On-Demand’, if events are not
to be printed until requested at the panel's
User Print menu, or ‘Continuous’ if events
are to be printed when they occur.

22
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Sw8g3 4w D50 [ 7]
dd/mmd ey r
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Panel Options (continued)

f.

Print Format. /D51/52, ID61/62 only. Click
the required size of characters to be printed
at the printer, either Single Height or Double
Height.

LED 1H Mode. The default function for this
LED is PRE-ALARM. This allows the
selection of alternative LED function of
SOUNDERS SILENCED.

. LED 2C Mode. The default function for this

LED is PLANT ALARM. The alternative
FAULT OUTPUT: FAULT/DISABLED
function can be selected.

UN-mute Internal Tone. Used to control
how new alarms un-mute the internal
buzzer, i.e. new alarms occurring in zones
not previously in alarm or for any new
device going into alarm.

Fire Output Active LED Option. Only
available if VdS Compatibility is set. Used
to select the condition under which the
Remote Fire Output Active LED illuminates
(either transmission device tigger or return
signal).
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9.2 Site Details

The Site Details tab allows you to set the
following:

a.

Site Name. Use this field to enter a site
name (maximum of 20 characters) for the
panel. The entered site name replaces the
‘Status: NORMAL' message on the panel
LCD. Text is entered at the current cursor
position; use the ‘backspace’ or ‘delete’
keys to erase characters.

Service Phone No. Use this field to enter
the phone number of the designated
servicing company (maximum of 20
characters). Alpha/numeric characters are
entered at the current cursor position; use
the ‘backspace’ or ‘delete’ keys to erase
characters.
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9.3 Device Options

The Device Options tab allows you to set the
following:

a. Blinking. Select polled-device blinking
either ‘On’ or ‘Off’.

b. Automatic Hightest Time. At a specified
time, the panel polls all devices and tests
that they can produce an alarm condition.
Place the cursor at the left-hand side of the
time field and enter the time of day (in
24-hour format) at which the test is to occur.
The cursor automatically moves to the right.
Check the ‘Enable’ box to enable the test
(or leave unchecked if the test is not
required).

c. Digital Input 1. Select the effect when the
panel’s Digital Input 1 is activated; either
‘Class Change’ (all Class Change-
configured outputs will operate) or ‘Day
Mode Start’ (Day Mode delays start).

d. Transmission Device. Applicable to
NF-Series panels only. Select the output
response of this device; either ‘Continuous’
(steady) or ‘6s Pulse’ (6 second pulsed).

CONTINUED...
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Device Options (continued)

e. FWP 2 Output Activation. Controls
f g h conditions under which an associated
Fireman’s Work Panel (FWP) operates the
Transmission Device-triggered output
(FWP2). Default state is to activate the
output when the Transmission Device output
is triggered. Optional state is to activate the
output when the Transmission Device

[ = return signal (via Digital Input 2) is triggered.
o0 | [

i - f. Pulse Ratio. Select the common value for

k—: all outputs configured as pulsing; either “1/1°

(one second ON, one second OFF) or ‘4/1’
(four seconds ON, one second OFF).

g. Day Mode Device Sensitivity. Set the start
and end times (24 hour-clock) at which
sensors use their ‘Day’ preset sensitivity
level instead of their ‘Night’ preset sensitivity
level. If the start and end times are the
same, Day Mode remains inactive. Does
not affect delays (Section 9.5).

h. Weekend Night Mode. If enabled, the
e i panel disregards Day Mode on the two days
of the week that coincide with the weekend.
Note: If an incorrect date has been entered at If disabled, Day mode applies to all days.
the panel, Weekend Night Mode may
not coincide with the weekend.
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i. Activation Delay Time. A common value
used by all Extinguishing System CBE
Rules (default 60 seconds). Use the spin
buttons or up/down arrows to select the
required time (minimum 10 seconds,
maximum 180 seconds).

CONTINUED...
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Device Options (continued)

J-

Soak Time. A common value used by all
Extinguishing System CBE Rules (default
0 = no limit). Limits the operating period of
these CBE Rules, to prevent damage to the
extinguishing system module. Use the spin
buttons to select the required time, or
highlight the current setting and enter a new
value (maximum 999 seconds).

Hold Switch Operation. Highlight the
required effect of the switch upon the CBE
operation. The options are:

AHJ. While a Hold Switch is active, the
activation delay timer is reset to the pre-
programmed value (this is the default).

NYC. While a Hold Switch is active, the
activation delay timer is reset to the pre-
programmed value plus 90 seconds and
paused.

ULI. While a Hold Switch is active, the
activation delay timer continues to count
down, and pauses at 10 seconds before
release.

IRI. Hold Switch activity is ignored if two or
more zones associated with the
Extinguishing System CBE are in alarm.
Otherwise the effect is the same as ULI.

Note: When the Hold Switch becomes

inactive, the activation delay timer
restarts.
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9.4 Peripheral Options

The Peripheral Options tab allows you to set
the following:

a. No. of Repeaters. Use the spin buttons to

select the number of repeaters installed on
the RS485 Communications link, or
highlight the current setting and enter a new
value (range 0 to 16).

. Repeater Protocol. Highlight the required

option:
DISABLED - disables communication
between the panel and repeater(s).

NOTIFIER - use with IDR-2A and IDR-2P
repeaters.

ARP50/RP50 - use with these repeaters.

THIRD PARTY - use with non-NOTIFIER
repeaters.

. RS232 Protocol. Highlight the required

protocol, either to connect a printer at the
panel's RS232 port, or to connecta computer
application that supports the 3rd party protocol.

. RS232 Options. Highlight the required option:

If ‘Printer’ was selected in (c) above, the
options are basic (data sent to printer at 20
characters/sec without data flow control),
XON/XOFF (software control of data flow)
or HARDWARE (control lines control data
flow - not applicable to ID50/60).

If ‘Third Party’ was selected in (c) above,
the options are FULL or HALF DUPLEX.
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Peripheral Options (continued)

e. Third Party Datalink Monitoring.
Monitoring of the RS232 Third party Datalink
can be set to ‘Enabled’ or ‘Disabled’.

f. Third Party Suspend Limit. Used to limit
the maximum time for suspending the RS232
Third Party Protocol Datalink. Enter a value of
1 to 300 minutes or a value of ‘0’ if an indefinite
period is required.
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9.5 Day/Night Settings

The Day/Night Settings tab allows you to set
the following:

a. Day Mode Delays. This function
automatically (unless input 1 is set to Day
Mode Start or the Day Mode Start Option is
set to Manual) enables the two-stage delay.
Set the Day Mode start and end times (24
hour-clock). If the start and end times are
the same, Day Mode remains inactive.
During Day Mode the activation or
deactivation of delayed outputs can be
overridden manually. This setting does not
affect sensor sensitivity (Section 9.3).

b. Weekend Night Mode. If enabled, the
panel disregards Day mode on the two days
of the week that coincide with the weekend
and enables the single-stage delay. If
disabled, Day mode applies to all days.

Note: If an incorrect date has been entered at
the panel, Weekend Night Mode may
not coincide with the weekend.

c. Day Mode Start Option. If Automatic is set,
Day Mode starts and ends at the times
configured in step a, otherwise Day Mode
is controlled manually at the panel.
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Day/Night Settings (continued)

d. Primary Delay Time. The Primary Delay
Timer is a common value (default
30 seconds) for all delay rules assigned to
outputs. Either use the spin buttons to
select the required time, or highlight the
current setting and enter a new value
(maximum 300 seconds).

e. Extend Delay Time. The Extend Delay
Timer is a common value (default
3 minutes) for all delay rules assigned to
outputs. Either use the spin buttons to
select the required time, or highlight the
current setting and enter a new value. If the
total delay time would exceed EN54
regulations (i.e. 10 minutes between fire
detection and activation of outputs), the
extend delay time is automatically reduced
to ensure this limit is not exceeded.
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f. End Delays Option. Select the method to
g f end delays: Two zones in alarm or heat
detector(s) in alarm, or both options.

g. Delays Active LED Indication. Select
whether only the DELAYS ACTIVE LED is
lit or the DELAYS ACTIVE and
DISABLEMENT LEDs for the indication of
active delays.
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10 Onboard Outputs

This display allows all of the six onboard output
circuits to be configured.

Each output can be assigned to a specific
output CBE Rule. The CBE Rule to which the
output is assigned can be edited.
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10.1 Configuration Option

The Onboard Outputs circuit configuration
display is used to specify the hardware output
type. This software configuration is in addition
to hardware jumper links (see the panel’s
Installation, Commissioning and Configuration
manual). The options are:

@

-~ 0o o 0 T o

Sounder (SDR).

Transmission Device (TxD).
Supervised Relay (CTL).
Unsupervised Relay (RLY).
Extinguishing System Output (ESO).
Extinguishing System Trigger (EST).

Extinguishing System Non-extinguishing
Ouput (ESE).

Relay Output Extinguishant Module (RLE).

Control Output Extinguishant Module
(CTL).

For each output, highlight the required option
from those available in the list.
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10.2 Control-by-Event (CBE) Rule Number

The operation of each Onboard Output is
controlled by one of up to 64 numbered
Control-by-Event (CBE) Rules. A CBE Rule
defines a set of input conditions (e.g. fire alarm
in specified zones) that will activate all the
outputs which have the Rule Number assigned
to them.

Use the keyboard to enter the Rule Number
(or Numbers separated by commas) to be
applied to the Onboard Output.

To edit a CBE Rule, select the corresponding
i button. The CBE Rules window is
displayed (refer to Section 12 CBE Rules).

Note: The last CBE Rule viewed on the CBE
Rule window is automatically entered
into the CBE Rule No. box when the
CBE Rule window is closed.
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11 Loop Device Configuration
11.1 Adding/Changing Device Settings

Use the scroll bar on the right-hand side of the
Device List View to scroll through the sensors or
= Panel Addres: modules. Up to 99 of each may be configured.

J'.']JJ) Onboard Outputs 20

To select a particular device, click on any field
— in the appropriate row or on the grey area to
Add/Change Sensors the left (or click on the device’s icon in the
= Connection View).

Delete ALL Senszors

The following sections describe each of the
fields.

11.1.1 Description

To change the existing device
description, or enter a new one,
click within the device’s text field.
Any existing text is highlighted and
can be deleted by pressing the
<delete> key, or can be overwritten
with any character.

Addreszs D escription PD | Group |~

2 warehouse 1

3 warehouse 2

4 warehouse 3
R aeamrnhnoinn 4

[ P

TUD 1nne 1nnes

Click again within the ‘description’

Addi ] iphi d T Al PA ] PD | G -~ . . . . .
e pr—— R [ RE S e o field. The text highlighting is turned
2 warehouse 1 10PT 100% 100% off and a cursor bar is shown. Insert
3| warchouse 2 110N 100% 100% new text at the cursor position (use
4 warehouse 3 1 MLT L3 L3
1

<backspace> and <delete> to

Rlwarahnines F- THMP 1nn 1nn% .
erase characters). The maximum
number of characters that can be
entered is 20.

To erase a word, double-click on it and then
press the <delete> key.
35 997-405, Version 2.7
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11.1.2 Zone Number

To change the zone number assigned to the
device, click in the ‘Zone’ field. The current
zone number is highlighted. It can be deleted
(i.e. set back to zone 1), or overwritten with
the desired zone number.

Address Deszcription Zone | Type | Alarm | PA Day PD | Group |~
u 1|reception
. 2 warehouse 1 1 0PT 1002 1002
l 3 warehouse 2 110N 100 1002
4 warehouse 3 1/ MLT L3 L3
Sensors and input modules (except AUX) can
be assigned to zones 1 - 16. AUX input
modules can be assigned to zones 17 - 32.
Module types SDR, RLY, CTL, TxD, EST, ESO,
ESE, RLE and CTE can be assigned to any
zone.
11.1.3 Device Type
To change the device type, or add a device,
click in the ‘Type’ field. The current type is
highlighted and a down arrow appears. Click
on the arrow to view the drop-down menu and
highlight the required type. Click to select it.
Address Deszcription Zone | Type | Alarm | PA Day PD | Group [«
4 eceptio TMA = (KD D03
2 warehouse 1 1¢: 100% 100%
3 warehouse 2 1 5';? 100% 100% 1]
4 warehouse 3 110N L3 L3 0
5 warehouse 4 1 E"FH; 100% 100% 0
& warehousze b 1| avs 100 100 U]
7 1|&%R 100% 100%
36 997-405, Version 2.7
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11.1.4 Sensors - Alarm/Day

Address | Description [Zone| Type | Alam | PA | Day [ PD | Goup |=]| These fields allow two sensitivity levels :
|| ; ::,Z';';Z:ﬂ : ;ﬁ': 1:1;1’4 - 1:1;]’4 s 1 to be set for the selected device. The o
B 3| warehouse 2 1hon o0z 100% ‘Alarm’ sensitivity is used during Night o
B awaehouses | 1|MLT | LEI - -- Mode and the ‘Day’ sensitivity is used e
5 warchouse 4 1w 1 ;ggg during Day Mode, if this mode is | 3"
B 7 office 1 1orx |0 |l s s 2 configured (see Section 9.3). To change o
N Blolfice 2 118v LL55 b s s s the sensitivity, select either the Alarm or =
= o ok e . Day field and enter the new value (for (®))
| 11 1- 100% 100% MULTI [MLT], VIEW™ [AVS & AVR] and '":
|| E 1 : 133; lgg; Optiplex [OPX] sensors, select the c
N o ] o e sensitivity level from the drop-down list). O
All sensors, except logical type TMP, can be o
allocated to a co-operative, multi-sensing
group. The default group is ‘0’ except for Q
VIEW™ sensors, which has the default group (&)
‘1’. The defaults can be edited as required e
(maximum of 50 groups) and device types can >
be used in any group. If sensors are required d’
to operate as stand-alone devices, they must Q
be put into group O. Q_
Note: If transferring a configuration from panel o
software earlier than version 5.00, the o
group number will be defaulted to ‘1’. This
must be changed to zero for all devices —I
that are not to be monitored using the
co-operative, multi-sensing group
algorithm.
37 997-405, Version 2.7
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VIEW™ Sensors

Click in the ‘Type’ field and select the
VIEW™ logical type, either ‘AVS’ (sensor)
or ‘AVR’ (reference sensor).

The columns headed ‘PA and ‘PD’ are specific
to VIEW™ sensors only:

a. ‘PA and ‘PD’ set the pre-alarm levels
for Night and Day Modes respectively.

b. When a VIEW™ sensor is selected it is
automatically assigned to the default co-
operative, multi-sensing group ‘1". If a group
contains both AVS and AVR types, the AVS’s
de-sensitise if the AVR’s detect a sudden
rise in contaminated air. If VIEW™ sensors
are required to operate as stand-alone
devices they must be put into group O.

Optiplex Sensors

Click in the ‘Type’ field and select the
OPX logical type. Click in the Alarm/Day
column and select one of six values
between L1 and L5; L1 being the most
sensitive and L5 the least sensitive.
Select L6 for the ‘Heat’ only option (see
note below).

Note: Optiplex sensor L6 functionality is only

possible with panel software version
5.00, or above. Optiplex sensors must
only be used with LIB software version
9.00, or above.

Address | Descriplion IZone| Type | Alarm | PA | Day | PD | Group |;|

| 1/ reception 1 TMF  100% 100%
| 2 warehouse 1 1 0PT 100% 100% 0
| 3 warehouse 2 1 10N 1003 100 0
| 4 warehouse 3 1 MLT L3 L3 0
| 5 warehouse 4 1 THP 100X 100%
| 6 warehouse 5 1 THP  100% 100%
| 7 office 1 1 0PX L5 L5 L5 L5 50
B ooz | tavs JEMis 15 s |1 |
| 9 office 3 1 AVR (L] L5 L5 s 1
i 10 |3 100%
| 11 1 L4 100%
|| 12 1- k2 100%
| 13 1) - L7 100%
L 14 1 La 100%

15 1 L 100%

Address Description IZoneI Type | Alarm | PA | Day | PD | Group I;I

|| 1 reception 1 TMP  100% 100%
|| 2 warehouse 1 1 0PT 100% 100% 0
|| 3 warehouse 2 110N 100% 100% 0
|| 4 warehouse 3 1 MLT L3 L3 0
|| 5 warehouse 4 1 TMP  100% 100%
|| 6 warehouse 5 1 TMP  100% 100%
o7 | 1jorx JEQR] 113 | 0 |
L g 1] - L1 100%
B 3 1- H 100%
L 10 1] - L4 100%

1 1]- Lg 100%
[ 17 1 LB 1NN
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11.1.5 Modules - AUX Actions

Address | Description I Zonel Type | Action I CBE Rule |;| The ‘Action’ field applies to modules
1 reception 1 MCP of type AUX Only. By default,
2| warchouse 1 1]MCP activation of these modules produces

3 warehouse 2 1 5DR 1.2
4 warehouse 3 1 RLY T a PLANT ALARM. To change the

> Y S T [ - o[- || effect, click in the *Action’ field. The

& warehouse § 17 AUX  ELeMT alaih current action is highlighted and a
7 office 1 1/sDR |RESET PAMEL 1 i

: SILENCE SOUNDERS down arrow appears. Click on the
3 officn 3 1 MoP | CLASS CHANGE arrow to view the drop-down menu,

1

1

w

8 office 2 MCP MUTE BLUZZER
10 R LA highlight the required action, then
1 FIRE BRIGADE CALLED] click to select it. Actions are:

a. PLANT ALARM.

b. Panel controls (RESET PANEL, SILENCE
SOUNDERS, MUTE BUZZER).

c. CLASS CHANGE.

d. Extinguishant system controls (ABORT
SWITCH, HOLD SWITCH).

e. FIRE BRIGADE CALLED.

Note: HOLD SWITCH has the effect selected
on the Setup Options display
(Section 9.3).

Priority Polling - Activation Time

The first 30 modules (from lowest address
upwards), restricted to types MCP, DKM, MRL,
IRL, and all AUX actions except Plant Alarm,
are added automatically to a priority poll list.
Subsequent modules are polled normally.
Auxiliary action inputs must be activated for a
sufficient period for the panel to recognise the
change. For priority-polled devices, activating
the input for 5 seconds should be sufficient.
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11.1.6 Modules - CBE Rules

Each Output Module, and some types of Input
Modules can be assigned to up to 24 CBE
Rules. Up to 64 CBE Rules can be configured.
However, if a module is assigned to more than
one Rule the range between the maximum and
minimum (base) must be 24 or less. The

You can enter a range of CBE currently-selected base is shown in brackets.
Rule numbers directly Default assignments are made in accordance
(bypassing the Range Entry with the module type.

window); e.g. 5-7,9 selects

Rules 5, 6, 7, and 9. The entry is not To change the CBE Rule:

recognised until you click outside of the 1 Click within the selected module’s CBE
CBE Rule entry field. R.ule.ﬂeld. The current Rule number(s) are
highlighted.
Address I Descriplion IZuneI Type I Action I CBE Rule Id 2 CIICk the ‘j’ bUtton (at the rlght Of the fleld)
s 1 toception_ L to display the CBE Range Entry window. (If
B 3lwachouse2 | 1]spR | [1iz] = the Base number is already set, you can
5 3 ussshonse 3 I T also enter the range directly, see Tip!).
St T s 3 Use the spin buttons (or direct number
entry) to set the Base CBE Rule number
HHERerpe Eaty - ""’d v——— (maximum 41); the window then shows 24
[ 2 ofthe 64 Rules, starting with the Base number.
: : 4 If activation of the module requires a Loop
[19-Fire [117 - Fire
[ 2 - General Pre-tlarm (110 - Fire 118 - Fire Booster to operate, check the Loop
H3;Pentwaning 11 Fie 18 fe Powered Output box. A+ is prefixed to the
[ 5 - Fire Output/ Transfer [] 13 - Fire 21 - Fire Base CBE Rule number.
Gl Sim o
H § Pese Hiafe H 35 e 5 Check the boxes at the left of those Rules
N | | to which the module is to be assigned.
' % Loop Powared Oulput To edit CBE Rules, either double-click a Rule or
BaseCBERUE  [1 2] Edit Fule | T ] click the Edit Rule button, then see Section 12.
40 997-405, Version 2.7

January 2005



ID5x/6x Series Panels - Offline Configuration Manual

RETIETYNE

Parel Addres
lﬂ?)} Orboard Outputs »
S} | oo — =

] Add/Change ¥ =Gt

: Delete b Modules

Add Sensors

Address
Fram: |1 ta IE‘ Zone I'I i’ TypelTMF‘ j

[ Ovenwrite defined devices

11.2 Adding a Range of Devices

In the Connection View area, right click on the
‘Loop’ icon to display the ‘Add/Change’ menu.
With ‘Add/Change’ highlighted, the ‘Sensors’
and ‘Modules’ options are displayed.

Select either ‘Sensors’ or ‘Modules’. Adialogue
window appears with fields for the device
addresses, zone number and type details.

Click in the ‘From Address’ field and use the
keyboard numeric keys to enter the lowest
address in the range. Click in the ‘To Address’
field and enter the highest address in the
range.

There may already be configured devices
within the address range. If the existing
configuration data for these devices is to be
overwritten, click the ‘Overwrite defined
devices’ check box. Leave this box blank if the
existing configuration data for these devices
is to be retained.

Use the ‘Zone’ spin buttons to select the zone
number into which the devices will be placed.

Click on the arrow to the right of the ‘“Type’ box
and highlight the required type from the
displayed list. All added devices will be
configured with this type.

When all fields have valid information, the ‘OK’
button is enabled. Click ‘OK’ to add the range
of devices to the device list.
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e e LR oM T mE |

= B Parel Addiess |
QJ)) Orboard Outputs 1
B0y Loop rE
[E-+-5® Senzars w 3

@ Delete sensor at address 2
NOTE: This may affect CBE
Rule assignments,

Ho |

S T R S =
Panel Address I
-} Orboard Outputs 1

=) e D

5 Add/Change » | H

Senzors
Modules
AL Devices
@ Delete ALL sensars 7
NOTE: This may affect CBE
Rule assignments,
Mo P
,
@ Delete ALL modules
MNOTE: This may remove CBE
Fiule assignments.
@ Delete ALL devices 7
NOTE: This will remave all

CBE Rule assignments.

11.3 Deleting Devices

11.3.1 Deleting an Individual Sensor/

Module

In the Connection View, right-click on the
required individual device icon. A pop-up menu
is displayed.

Click on ‘Delete Sensor’ or ‘Delete Module’
(depending upon the device type). A Confirm
window is displayed.

Click on ‘Yes'. The device is removed from the
device list.

11.3.2 Deleting All Sensors/Modules

In the Connection View, right-click on the ‘Loop’
icon. A flyout menu is displayed. Highlight
‘Delete’ to display the ‘Sensors’, ‘Modules’ and
‘All Devices’ options.

Click on the required ‘Delete’ option. The
appropriate Confirm window is displayed.

Click on ‘Yes’. The devices are removed from
the device list.
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CBE Rules [ x]

33| 34| 36| 36| 37| 58| 8] 40| #1) 42| 43| 44| 45] 48] 47 45| 48] w0] 51| 62] 52| 54| 66| 58| 67| vs| 5| e0] €1 62| 2] &)
.2 Ja]a]s|s]z]e]|a]m|n]we]e|w]e]w]n]e]s]|]a]z| |2t 2] 2 27 28] 25| 20] 1] 2]

1~ Riule Detail

Rule Number

I O O O O ) B .4

Zone | Condition

90N
100N
110N
120N
13/0N
140N
150N
16/0N

Setall ON

Fule Type [Fye -
Eiter Type  [any - any Device -

¥ Evacuats I EriebileSiak Tiirer
¥ Sience ¥ Intenuptable

I IwoZone I™ LClass Change

Device Kind Addiess  Type

Deviced hgised 7 |1 Hf
Device 2 igised 7 |1 Hf
= Device 3 ngised 7 |1 Hf

| setanorr |

12

Frevious Rule | Hext Rule |

Control-by-Event (CBE) Rules

This section applies to both Onboard Outputs
(see Section 10) and Loop Modules (see
Section 11.1.6). These are collectively
referred to here as outputs (but remember that
some types of Input Modules can be
associated with the CBE Rules).

An Onboard Output can have one CBE Rule
associated with it; a Module can have up to 24.
The Onboard Outputs or Modules controlled by
agiven Rule are referred to as ‘assighed outputs’.

Up to 64 numbered Rules can be defined. The
CBE Rules window has 64 tabs located across
its top, each of which displays a corresponding
Rule. A typical Rule includes the following
parameters:

a. Rule Type. This defines the event that must occur (e.g. Fire, General Fault, Plant Warning, etc.) to activate
the output. Depending upon this selection, some options may be unavailable (greyed out). See Section 12.1.

Filter-by-Type. Two filter lists are provided; one is applicable to Fire, Pre-alarm and Fault Rule
Types only, and the other to the Extinguishing System Rule Type only. See Section 12.2.

Input Zones. Applicable to Fire, Plant Warning and Extinguishing System Rule Types only. This defines
in which zone(s) the Rule Type event must occur to activate the outputs. For each zone that is included
in the Rule, the condition in which the zone will activate can be modified (e.g. a delay occurs, or co-
incident alarms are required; the options available depend upon the Rule Type). See Section 12.3.

b.

. Control Parameters. These define the effect on the output of certain panel pushbuttons, or whether

a Fire or Plant Warning must occur in two zones simultaneously to activate the output, or whether
the Extinguishing System Rule Type will start the extinguishant soak timer. See Section 12.4.

If the Rule Type is ‘Device Input’, up to three devices can be selected as the input. See Section 12.5.

To select a different Rule number, click on the appropriate tab or the ‘Previous Rule’’’Next Rule’
buttons. Each Rule Number displays its current settings. When all edits have been completed, click

on the ‘Close’ button to return to the configuration file.
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12.1 Rule Type

Bule Type  [Fpe j
- ; The Rule Type drop-down menu allows the
Dewice Input userto char)ge the Rule Type. Select the down
General Fault arrow to display the available types, then
General Pre-larm highlight the one that is required.
F'_Iant W arning
;'Lientumuwramfer The nine Rule Types have the following effects
Day Mode (may be modified by Control Parameters - see
E stinguizhing System Section 12.4):
General Dizablement

a. Fire Rule Type.Activates its assigned outputs in response to fire alarms in specified zones (may
be modified by Zone Actions - see Section 12.3).

b. Device Input Rule Type. Activates its assigned outputs in response to input(s) from one of up to
3 specified devices.

c. General Fault Rule Type. Activates its assigned outputs in response to a general fault condition
at the panel.

d. General Pre-Alarm Rule Type. Activates its assigned outputs in response to general pre-alarms.

e. Plant Warning Rule Type. Activates its assigned outputs in response to plant alarms in specified
zones (may be modified by Zone Actions - see Section 12.3).

f. Fire Output/Transfer Rule Type. Activates its assigned outputs in response to the Fire Output/
Transfer relay being operated (i.e. General Fire).

g. Reset Rule Type. Activates its assigned outputs for 5 secs in response to a panel reset.
h. Day Mode Rule Type. Activates its assigned outputs when the panel is operating in Day Mode.

i. Extinguishing System Rule Type. Activates its assigned outputs and reads its assigned inputs
in response to fire alarms in specified zones (may be modified by Zone Actions - see Section 12.3).

j. General Disablement Rule Type. Activates its assigned outputs in response to general
disablements.

By default, Rules 1, 6 and 8-64 are set to Fire, 2 to General Pre-Alarm, 3 to Plant Warning, 4 to
General Fault, 5 to Fire Output/Transfer and 7 to Reset. However, all Rules can be edited.
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FIRE RULE
Eilter Type ﬁNY - Ay Dew:e

EITI Sensnrs[EIF'Ta’TMF'.-’IDN.-’MLT]
AWS -WIEW Sensars

FCP - Manual Call Points

FOM - Monitor Modules

PRE-ALARM RULE

Eilter Type

AMY - .-“-‘-.ny Device

EITI Sensurs[DF‘Ta’TMPJIDNJMLT]
AS - WIEW Sensorg

Eilter Type:

Smoke/Heat

Sensars’MEF‘
WIEW fSenzor
Ay Two Zones
A Two Senzors
Ay Single Sensor
Arw Single Module

12.2 Filter-by-Type
12.2.1 Fire, Pre-Alarm, Fault Rule Types

The assigned outputs are only activated/inputs
are only read if the event occurs in the assigned
zone(s) at the configured type of input device:

a.

ANY. Activate irrespective of the type of
input device at which the event occurs.

OTI. Only activate ifthe input device is an analogue
sensor (Optical, Thermal, lonisation or Multi).

AVS. Only activate if the input device is a
VIEW™ sensor. Applicable only for those panel
variants that support VIEW™ (e.g. ID60, NF50).

MCP. Only activate if the input device is a
manual call point (not available for Pre-alarm).

MON. Only activate if the input device is a
monitor module (not available for Pre-alarm).

12.2.2 Extinguishing System Rule Type

The assigned outputs are only activated/inputs
are only read if the selected event occurs in
the assigned zone(s):

a.
b.
c.

One smoke and one heat sensor in alarm.
One sensor and one MCP or ZMX in alarm.

One VIEW™ sensor and one other type of
sensor in alarm (if panel supports VIEW™).

. Any two devices in alarm, but must be in

different assigned zones.
Any two sensors in alarm.
Any one sensor in alarm.

. Any one module in alarm.
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Bule Type IF"E

—Fule Detail

[

Zone I Condition

[

1.0H

2 E0M

DELCAYED
COINCIDENCE
4 |PULSED

£ [OFF

L]

B OM

Bule Type I Flant ' arming

~Fiule Detail

Zone | Condition

»

17 0N

18 N

19 COIMCIDEMCE
FPULSED
20| 0FF

Bule Type IEHtinguishing System

Fiule Detail

Zone | Condition

1 DELAYED

2 E0M

, [DELCETED
OFF

4 TR

12.3 Zone Actions

For Fire, Plant Warning and Extinguishing
System Rule Types it is possible to define
which zones are included in the input to the
Rule. If a zone is included, its action can be
modified - the modifying conditions vary with the
Rule Type as shown opposite. The options are:

a.

ON. The zone is included in the Rule. An
alarm in this zone will activate the output
immediately in continuous mode.

DELAYED. The zone is included in the Rule.
An alarm in this zone will activate the output,
after adelay (see Section 9.3), in continuous
mode. Not available for Fire Rules if Two Zone
is selected. Extinguishing System Rules
default to delay. The following does not apply
to Extinguishing System Rules: If a Day
Mode period is set (see Section 9.5), the
delays must be activated manually during
this period. Also, delays are then NOT
active outside of the Day Mode period.

COINCIDENCE. The zone is included in the
Rule. The output will activate immediately
in continuous mode when there are two
alarms in this zone (one alarm has no effect).

PULSED. The zone is included in the Rule.
An alarm in this zone will activate the output
immediately in pulsed mode (see
Section 9.3). However, the pulsed mode is
overridden by a continuous alarm if an alarm
occurs in any zone which is included in the
Rule and for which PULSED is not selected.

OFF. The zone is not included in the Rule.
CONTINUED...
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Zone Actions (continued)

Click the mouse in the required zone’s
‘Condition’ box and select the required option
from the drop-down menu.

To set ALL zones to ON or OFF, click on the
‘Set All ON’ or ‘Set All OFF’ button respectively.

Zones 1 to 16 are configurable when the Rule
Type is Fire or Extinguishing System. Zones
17 to 32 are configurable when the Rule Type
is Plant Warning.
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[¥ Ewacuate [T Enable Soak Timer
¥ Silence ¥ Intemmaptable
[T TwoZone [T Class Change

EN54-2: 7.11.d
Configured delays
MUST be set to
interruptable.

12.4 Control Parameters

If allowed by the Rule Type, the operation of an
output assigned to the Rule can be further defined
by Control Parameters. These are selected by
check boxes. Options unavailable for the current
Rule Type are greyed. The options are:

a. Evacuate. Activates assigned outputs
when the END DELAY/EVACUATE
pushbutton is operated at the panel.

b. Silence. Silences assigned outputs when
the SILENCE/RESOUND pushbutton is
operated at the panel. If this option is not
selected, the outputs will only turn off (after
being activated) when the panel's RESET
pushbutton is operated.

c. Interruptable. Ends any delays when the
END DELAY/EVACUATE pushbutton is
operated at the panel. If this option is not
selected, delays cannot be interrupted
except by another qualifying alarm
condition that turns the output on.

d. Two Zone. Applies to the Fire and Plant
Warning Rule Types only. Restricts
assigned outputs such that they do not
activate until two of the input zones included
in the Rule have detected alarms.

e. Class Change. Activates assigned outputs
in conjunction with a configured input via
Digital Input 1 (see Section 9.3).

f. Enable Soak Timer. Applies to the
Extinguishing System Rule Type only. The
Rule starts the extinguishing module timer.
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12.5 Device Inputs
If the Rule Type is Device Input, the assigned

outputs are activated when the input from one
of up to three pre-defined input devices

becomes active. For each device:

= EhEtlE Sk Timer 1 Click on the arrow to the right of the ‘Device
Kind’ box to display the device type options:
I= | rterptatle Sensor, Module or Not Used. The latter

option allows fewer than three devices to
be included in the Rule. Highlight to select
the appropriate option.

2 Use the spin controls to the right of the
‘Address’ box to select the Sensor or
Module address. Only those addresses
already configured on the loop (see
Section 11) are available. The device type
is displayed but this is not editable.
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13 Zone Text

Display the Zone Text window either from the
......... View menu, or by right-clicking the panel icon
— in the Connection View and selecting ‘Edit /
Zone Text' from the pop-up menu.

Zone Text

All 32 zones are listed in an uneditable ‘Zone’
field. Click in the ‘Text’ field to the right of the
zone and enter the zone name (maximum
20 characters). Any existing text is highlighted
and can be overwritten, or can be deleted by
pressing the <delete> key. When all edits are
complete, click on the ‘Close’ button.

To clear all zone text in the Zone Text window;:

1 Click on the ‘Clear All Zone Text’ button. A
Confirm window is displayed.

-
>
et
Q
c
O
N

Confirm 2 Click on ‘Yes'. All zone text fields become
blank.
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Make regular saves to limit
the amount of data lost due
to computer problems.

@ NEW FILE - ID5x/6x Series Windows Support Tool

3[R Edit “iew Toolz Help

[0 Mew Ctrl+M
4 Open... Chd+00
[H save Chrl+5
Save As H
Savein | (= ID5EEw Series Tool Rl =]
1 Motifier. udt
File name: I Save I

Save az ype: ||[:|5:-:.-"BH Configuration File

j Cancel |

Confirm

@ Save changes 7

14 Saving a Configuration File

To store a configuration file, use one of the
following methods:

a. SAVE. Saves an updated file with existing
name and location. To Save, click the ‘Save’
button on the Command Tool bar or select
the ‘Save’ option in the ‘File’ menu.

b. SAVEAS. Saves a new or updated file, with
new name and/or location. To Save As,
select the ‘Save As’ option in the ‘File’ menu.

Use the standard Windows® navigation tools
to select the required directory. Enter the
required file name and click on the ‘Save’
button. The configuration file is automatically
given the extension ‘.udf’.

Save changes dialogue window

Closing a file which has unsaved changes
automatically displays the ‘Save changes’
Confirm window. Click on the ‘Yes’ button. If
the file already has a name, the changes are
saved to disk, otherwise the ‘Save As’ window
is displayed to allow a name to be entered.
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() MAIN BUILDING_UDF - ID5x/6x Series Wind

File Edit iew NN Help
O A | gnﬁendtuF‘anel

% Receive from Panel

Ctrl+T
Chil+R

Fetch Event Log

Fetch Device Data

Log Device

EM“’I’: ,}y‘ Serial Port Setup

Ctrl+E

Language 4

Configuration Transfer
Searching for ID5R/Gx Panel an COMT..
Configuration Transfer

|D5w/Ex Panel MOT found.
The panel could not be detected on COM1.

Enzure that the panel i connected ta the
computer az specified in the manual,

Betry

[Retries: 10)

15 Communications with the
Panel

Configuration data can be sent to or received
from the panel. Before any data is sent to the
panel, the panel's memory lock jumper (see
panel manual) must be set open. When the
data has been successfully transferred, the
jumper must be closed. It can remain closed
while data is received from the panel.

Configuration Transfer

To transfer data, the Data Transfer Lead must
be connected between the PC and the panel.
Ensure the lead is connected to the correct
COM port. If this cable is not connected, the
window shown at left is displayed.

Ten attempts are made to connect the PC and
panel. To abort these attempts, click on the
‘Abort’ button.

After the tenth attempt at making a connection,
the display changes to that shown at left.
Either:

a. Fit the Data Transfer Lead and then click
on the ‘Retry’ button, in which case ten more
attempts are made to connect the PC and
panel, or

Click on the ‘Abort’ button to end the
connection process.
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J Send to Panel Crl+T
E‘ Receive from Panel  Chil+R

Fetch Event Log
Fetch Device Data

Log Device

O C il Dt Tt ChlC

Issue 1 of the panel
software is not passcode

15.1 Send Data to Panel

Ensure the panel's memory lock is open (see
panel manual), then select the Tools menu and
click on the ‘Send to Panel’ option. The
‘Configuration Transfer’ window prompts for a
passcode.

protected.
Configuration Transfer Click in the ‘Passcode’ box and use the
numeric keys to enter the level 3 numeric code.
Panel Passcode Protectad Click on the ‘Start Transfer’ button to send the
data. The ‘Send to Panel window is displayed.
Enter level 3 paszcode to enable write
access ko the panel -
Fazzcode Ixm1
Start Transfer | Abort |
Send to Panel The progress of the data transfer is shown by
a bar and by a message. The number of
> n attempts to complete the transfer is also
— displayed. An ‘Abort’ button is provided - see
Section 15.3, which has important information
] regarding use of ‘Abort’ while sending data.
When the data transfer is complete, the
[Retries: 0 [Transterring CBE Rules. Configuration Template View is displayed.
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II:I |:|| 1

n Send to Parel Ctrl+T

% Beceive fram Panel  Chl+R

Fetch Event Log

Fetch Device Data

Log Device

il Dt T Ml C

Receive from Panel E3 |

o =

|Retries: 0 | Transtening Point Configurations.

Confirm

Communications F ailure.
Continue ?
Abort |

15.2 Receive Data from Panel

From the Tools drop-down menu, select the
‘Receive from Panel’ option. When the PC is
receiving data from the panel, the ‘Receive
from Panel’ window is displayed.

The progress of the data transfer is shown by
a bar and by a message. The number of
attempts to complete the transfer is also
displayed. An ‘Abort’ button is provided - see
Section 15.3.

When the data transfer is complete, the
Configuration Template View is displayed.

It is also possible to receive the event log or
device data, and to view device data in real
time. Refer to Section 5.4.

Communications Failure

If there is a communications failure, e.g. the Data
Transfer Lead becomes disconnected, the PC
makes 10 attempts to receive the data. After the
tenth attempt, the window shown at left is displayed.

To continue with attempts to receive the data,
i.e. if you are going to reconnect the Data
Transfer Lead, click on the ‘OK’ button. The
prompt is re-displayed after every 10th attempt
to receive the data. To stop attempting to
receive data, click on the ‘Abort’ button.
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15.3 Abort Transfer

If the ‘Abort’ button is operated on the ‘Send
to Panel’ window or ‘Receive from Panel’
window while a data transfer is in progress,
the ‘Abort Transfer’ prompt is displayed.

Confirm

To stop the data transfer, click on the ‘Yes’
button. Complete configuration file sections
already sent to the panel will be saved and
updated in the panel (see warning opposite).
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To continue with the data transfer, click on the ;
‘No’ button.
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16 Printing

@ MNEW FILE - ID5x/6x Series Windows S The following options are provided:
File a. Print Preview. Used to ensure that the
' selected pages will print correctly. See
Section 16.1.

b. Print. Used to print the selected pages. See
Section 16.2.

c. Printer Setup. Used to configure the printer.
See Section 16.3.

Note: These options are not available if there
are no printers installed on your PC.

All these options can be accessed from the
‘File’ drop-down menu. The ‘Print Preview’ and
‘Print’ options can also be accessed directly
from icons on the Command bar (see
Section 6).
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O Mew Chrl+M

= Open... Chd+0

n Save Chl+5
Save bz,

@ Frint Preview

& Piint Chil+P
Frinter Setup

a b

3 s oES

Pansl Sstup Cptions

16.1 Print Preview

This option displays the Print Preview window.
The window is divided into three areas:

a. Navigation Pane.
b. Command Bar.

c. Preview Page view.

Navigation Pane

The Navigation Pane is displayed down the
left-hand side of the Print Preview window. It
is used to select the data that appears in the
Preview Page view. To view printable data, click
on the relevant thumbnail (each is sub-titled)
in the Navigation Pane; the selected thumbnail
outline is emboldened.

To select the data for printing via the printicon,
click on the corresponding thumbnail. If further
thumbnails exist above or below those
currently displayed, use the up/down arrows
or slider bar to view them.
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(@ Print Preview

Print Preview (continued)

The Command Bar is displayed across the top

of the Print Preview window.

The options available from the Command bar are:

a.

Page Selector. Use the spin controls to
select page 1 or 2 (if applicable) of the
current view selected by the thumbnails.

Print button. Click to print the page(s)
associated with the current view.

Zoom to Fit button. Click to resize the page to
fit the entire area within the Preview Page view.

. Zoom to Width button. Click to resize the

page to fit the width of the area within the
Preview Page view; part of the page may
then be hidden.

Maximise Preview button. Click to resize
the Print Preview window to fit the PC’s
screen. Second operation returns the Print
Preview window to its original size.

Close button. Click to exit from the Print
Preview window.
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Print Preview (continued)

Preview Page View

[ The Preview Page view displays the page
selected from the Navigation Pane.
e [ 3 @ ol
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16.2 Print

Print Selection This menu option displays the Print Selection
window (note that this option does not have
the same effect as using the Print icon on the
Print Preview Command Bar).

The window has one check box for each
printable view. Check each view that is to be
printed, then click the ‘OK’ button to print the
checked views. By default, all boxes are
checked.

16.3 Printer Setup

Print Setup =] This option displays the Print Setup window.

Click on the arrow at the right-hand side of the

‘Printer’ box to display a drop-down list of
available printers (if more than one is
-ﬂ available). Highlight and click on the required

Ii Ii printer.

Use the spin buttons to display the required
number of copies in the ‘Copies’ box.

Click the ‘OK’ button to accept this setup.
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